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AN4833 
SAM E54 MCU 向け MPLAB Harmony v3 TCP/IP スタックを

使った FTP (File Transfer Protocol) 

はじめに

FTP (File Transfer Protocol) は、デバイス間のファイル転送用に TCP/IP によって提供される標準インターネット プ
ロトコルです。FTP は、TCP/IP スタック層内のアプリケーション層プロトコルです。Embedded FTP クライアント

/サーバは、どのようなネットワーク対応デバイスにも利用できる追加機能です。FTP クライアント モジュールを使

うと、お客様のアプリケーションと FTP サーバの間でファイルをアップロードおよびダウンロードできます。この

プロトコルにより、ホストのファイル ストレージ システムを気にする事なく、異なるデバイス間で信頼性の高い効

率的なデータ転送が可能となります。

本書では、MPLAB® Harmony v3 TCP/IP スタックの FTP 実装に焦点を合わせます。また、SAM E54 マイクロコン

トローラを使った FTP クライアントおよび FTP サーバのデモも提供します。この FTP クライアント アプリケーシ

ョンは、FTP サーバからアプリケーション バイナリをダウンロードし、自己書き込みによってファームウェアを更

新する Ethernet ブートローダ機能を備えています。 

略語

• FTP:  File Transfer Protocol
• HTTP:  Hypertext Transfer Protocol
• TCP/IP:  Transmission Control Protocol/Internet Protocol
• DHCP:  Dynamic Host Configuration Protocol
• DFP:  Device Family Pack
• MCC:  MPLAB Code Configurator

注意 : この日本語版文書は参考資料としてご利用ください。

最新情報は必ずオリジナルの英語版をご参照願います。
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FTP の概要 
 

 

 
1. FTP の概要 

FTP は、クライアントとサーバの間で制御用とデータ用に別々の接続を使うクライアント/サーバ モデル アーキテク

チャに基づきます。FTP クライアントはホストとリモート FTP サーバの間で接続を確立し、TCP を介して 2 つのコ

ンピュータの間で双方向のデータおよびファイル転送を提供します。FTP は、クライアントがドメイン、IP アドレ

ス、ポート、ユーザ名、パスワードを指定する事により FTP サーバに接続した時に機能します。ユーザ認証後に、

両システムの間の接続が確立され、ホスト コンピュータは FTP サーバへデータをアップロードできます。FTP サー

バの管理者がサーバ上の各種ファイルおよびフォルダのダウンロードに対してアクセス制限を設定している場合があ

ります。 

FTP は、クライアントとサーバの間で 2 つの接続 (通信を制御するためのコントロール コネクションとファイルの内

容を転送するためのデータ コネクション)を使います。クライアントとサーバ間の FTP セッション開始時に、クライ

アントはサーバ側とのコントロール TCP コネクションを開始する事で、サーバへ制御情報を送信します。サーバは

制御情報を受信した時に、クライアント側へのデータ コネクションを開始します。FTP セッションはアクティブモ

ードまたはパッシブモードで動作します。これらのモードにより、データ コネクションの確立方法(クライアントと

サーバのどちらが転送を開始するか) が決まります。FTP のモードと接続に関するその他の情報は、アプリケーショ

ン ノート AN3475 に記載しています。 

https://ww1.microchip.com/downloads/en/Appnotes/File-Transfer-Protocol-Using-MPLAB-Harmonyv3-TCPIP-DS00003475A.pdf
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2. 応用例の概要 

本書では、2 つの SAM E54 Xplained Pro 評価用キット(FTP サーバ用と FTP クライアント用に 1 つずつ) 使って、ネ

ットワーク内の FTP サーバと FTP クライアントの使い方を説明します。FTP クライアントと FTP サーバは、それぞ

れ独自のファイルシステム用ストレージ メディアを備えます。クライアント ボードとサーバ ボードは、それぞれの

IO1 Xpro ボード上の SD カードをファイルシステム用ストレージ メディアとして使ってファイルを転送します。本書

の応用例では、クライアントからサーバにログインしてアプリケーション バイナリをダウンロードするための FTP
ネットワーク動作に焦点を合わせます。 
 
図 2-1.   SAM E54 を使ったクライアントおよびサーバモデル 

 
 
 
図 2-2.  アプリケーションとブートローダのメモリ配置 
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3. ハードウェアおよびソフトウェア要件 

本書の応用例に対するハードウェアおよびソフトウェア要件は以下の通りです。 

ハードウェア: 

• SAM E54 Xplained Pro 評価用キット x2 
• IO1 Xplained Pro ボード x2 
• microSDカード x2 
• Ethernet ケーブル(RJ45)  x1 
• USB ケーブル  x2 

ソフトウェア: 

• MPLAB X IDE (v6.00) 
• MPLAB XC32 コンパイラ(v4.10) 
• MPLAB Code Configurator (v5.1.17) 

– Harmony bsp リポジトリ v3.13.0 (Github bsp) 
– Harmony csp リポジトリ v3.13.1 (Github csp) 
– Harmony core リポジトリ v3.11.1 (Github core) 
– Harmony dev_packs リポジトリ v3.13.0 (Github dev_packs) 
– Harmony net リポジトリ v3.8.0 (Github net) 
– Harmony Crypto リポジトリ v3.7.6 (Github crypto) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

https://github.com/Microchip-MPLAB-Harmony/bsp
https://github.com/Microchip-MPLAB-Harmony/csp
https://github.com/Microchip-MPLAB-Harmony/core
https://github.com/Microchip-MPLAB-Harmony/dev_packs
https://github.com/Microchip-MPLAB-Harmony/net
https://github.com/Microchip-MPLAB-Harmony/crypto
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4. MPLAB Harmony v3 における FTP 
MPLAB Harmony v3 TCP/IP スタック ライブラリは、使い易い C 言語インターフェイスを備えた FTP モジュールの

API を提供します。これは FTP サーバと FTP クライアントをサポートし、ファイルのアップロードとダウンロードを

容易に行えます。 
 

4.1 TCP/IP Configurator 
MPLAB Harmony v3 の設定には MPLAB Code Configurator (MCC)を使います。MCC により、GUI を使ってデバイスの

セットアップ、ライブラリの選択、設定、アプリケーション開発が容易に行えます。TCP/IP の設定には TCP/IP 
Configurator プラグインが使えます。これにより、GUI を使って TCP/IP 機能を MPLAB Harmony v3 プロジェクトに対

して追加または削除し、アプリケーション要件に応じて各コンポーネントを設定できます。TCP/IP Configurator プラグ

インは、「Project Graph」ウィンドウ内の[Plugins]ドロップダウンから選択できます(図 4-1 参照)。 
 
図 4-1.  TCP/IP Configurator 

 
 
「TCP/IP Configurator」ウィンドウには、最初に各種 TCP/IP 層の概要がグラフィカルに示されます。各層を選択する

と、利用可能なコンポーネントが表示されます。「Available Components」リストから「+」アイコンのクリックまた

はドラッグ&ドロップにより、選択したコンポーネントを追加します。選択中のコンポーネントに対して不足している

依存性を追加するために、ポップアップ ウィンドウが表示されます。「Project Graph」ウィンドウ内で、追加した

TCP/IP コンポーネントのいずれかを選択して[Configuration Options] 内で設定を追加します。 
 
図 4-2.  TCP/IP Configurator の概要 

 
Note: 「net」のローカル リポジトリ内にある「docs」フォルダには、Configurator に関するその他の情報が格納され

ています。 

https://www.microchip.com/mplab/mplab-harmony
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4.2 FTP サーバ モジュール 
FTP サーバ機能を使うと、組み込みデバイスからファイルのアップロードおよびダウンロードが容易に行えます。

FTP TCP/IP スタック ライブラリ インターフェイスは、ftp.h ヘッダファイル内で定義されます。FTP サーバを使

うために、プロジェクトには TCP/IP スタックとファイルシステム(本書のプロジェクトでは FAT FS) を使う必要が

あります。 

FTP サーバは、MCC を使って MPLAB Harmony v3 TCP/IP プロジェクト内で有効にできます(Project Graph > 
Plugin > TCP/IP Configuration > Application Layer > Add FTP Server)。 

図 4-3.  TCP/IP Configurator 内の FTP サーバ 

 
 
 
表 4-1.  FTP サーバモジュールのファイル 

ファイル 概要 

ftp.h FTP サーバ TCP/IP スタック ライブラリへのインターフェイス 

ftp.c FTP サーバの実装 
 
 

4.3 FTP クライアント モジュール 
FTP クライアント モジュールにより、ホストごとのファイル ストレージ システムの違いを気にする事なく、デバ

イス間で信頼性の高い効率的なデータ転送が可能になります。FTP クライアント TCP/IP スタック ライブラリ イン

ターフェイスは、ftpc.h ヘッダファイル内で定義されます。 

FTP クライアントは、MCC を使って MPLAB Harmony v3 TCP/IP プロジェクト内で有効にできます(Project Graph 
> Plugin > TCP/IP Configuration > Application Layer > Add FTP Client )。 
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図 4-4. TCP/IP Configurator 内の FTP クライアント 

 
表 4-2.  FTP クライアント モジュールのファイル 

ファイル 概要 

ftpc.h FTP クライアント TCP/IP スタック ライブラリへのインターフェイス 

ftpc.c FTP クライアント プロトコルの実装 
 

表 4-3 に、FTPC モジュールがサポートする FTP コマンドを示します。 

表 4-3.  FTPC モジュールがサポートする FTP コマンド 

FTP コマンド スタックコマンド タイプ 関数名 

USER: ユーザ名を送信する TCPIP_FTPC_CMD_USER TCPIP_FTPC_Login 

PASS: パスワードを送信する TCPIP_FTPC_CMD_PASS TCPIP_FTPC_Login 

ACCT: アカウント情報を送信する TCPIP_FTPC_CMD_ACCT TCPIP_FTPC_Login 

TYPE: 転送タイプを設定する TCPIP_FTPC_CMD_TYPE TCPIP_FTPC_SetType 

STRU: 転送ファイルの構造を設定する TCPIP_FTPC_CMD_STRU TCPIP_FTPC_SetStruct 

MODE: システムモードを設定する TCPIP_FTPC_CMD_MODE TCPIP_FTPC_SetMode 

PASV: パッシブモードへ移行する TCPIP_FTPC_CMD_PASV TCPIP_FTPC_SetPassiveMode 

PORT: データポートを開く TCPIP_FTPC_CMD_PORT TCPIP_FTPC_Connect 

RETR: リモートファイルを取得する TCPIP_FTPC_CMD_GET TCPIP_FTPC_GetFile 

STOR: リモートホストにファイルを保存する TCPIP_FTPC_CMD_PUT TCPIP_FTPC_PutFile 

NLST: リモート ディレクトリの名前の一覧を表

示する 
TCPIP_FTPC_CMD_NLST TCPIP_FTPC_NameList 

LIST:  リモートファイルの一覧を表示する TCPIP_FTPC_CMD_LIST TCPIP_FTPC_List 

DELE:  リモートファイルを削除する TCPIP_FTPC_CMD_DELE TCPIP_FTPC_DeleteFile 

CWD:  ワーキング ディレクトリを変更する TCPIP_FTPC_CMD_CWD TCPIP_FTPC_Change_Dir 

CDUP:  カレント ディレクトリの親ディレクト

リへワーキング ディレクトリを移動する 

 
TCPIP_FTPC_CMD_CDUP 

 
TCPIP_FTPC_ChangeToParentDir 
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...........続き 
FTP コマンド スタックコマンド タイプ 関数名 

MKD:  リモート ディレクトリを作成する TCPIP_FTPC_CMD_MKD TCPIP_FTPC_MakeDir 

RMD:  リモート ディレクトリを削除する TCPIP_FTPC_CMD_RMD TCPIP_FTPC_RemoveDir 

PWD:  ワーキング ディレクトリを表示する TCPIP_FTPC_CMD_PWD TCPIP_FTPC_Get_WorkingDir 

QUIT:  接続を終了する N/A TCPIP_FTPC_Logout 
 

クライアント モジュールは、FTP コマンドの実装に加えて、USART ターミナルを介するユーザ インターフェイスを

提供します。ユーザは、このターミナルに入力する事により、必要な FTP コマンドを提供できます。全ての FTP ク

ライアント コマンドは、キーワード「ftpc」で始まります。 

例:  ftpc login <username> <pswd>  
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5. FTP クライアント/サーバ:応用例の実装 
以下では、本書の応用例を実装するための前提条件について説明します。 

 

5.1 MPLAB Harmony v3 の設定 
•   MPLAB X IDE を使って SAME54P20A 向けに 32 ビット MPLAB Harmony v3 プロジェクトを作成するには、

https:// microchipdeveloper.com/harmony3:same54-getting-started-training-module を参照してください。 
•  Confguration の起動時に Device Family Pack (DFP)、System、CMSIS Pack、NVMCTRL、EVSYS が既定値によ

り提供されます。 
•   IO1 Xplained Pro 基板から SD カード向けインターフェイスを提供するため、SD Card (SPI)ドライバが追加され

る必要があります。 
•   要求される Satisfiers と併せて CONSOLE、COMMAND、DEBUG、TIME、FILE SYSTEM、TCP/IP 機能を含む

システムサービスが追加される必要があります(図 5-1 参照)。 

図 5-1.  FTP クライアント/サーバの Project Graph

 
 

5.2 TCP/IP MPLAB Harmony v3 の設定 
クライアントおよびサーバ向けに TCP/IP Basic Configurator を設定するための手順は以下の通りです。 

1.   TCP/IP Configurator は、「TCP/IP Configurator」で説明した方法で開きます。選択された内容が追加されると、

それらは TCP/IP Configurator または Project Graph から表示できます。各種の表示が Project Graph から選択

できます(図 5-2 参照)。 
 
図 5-2.  表示の選択 

 
2. 「Basic Configuration」画面では、TCPIP CMD および TCPIP CORE コンポーネントが有効にされます。 
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図 5-3.  Basic Configurator 

 
Note: 「TCP/IP CORE」設定オプション内で、TCP/IP スタックの動的 RAM サイズをアプリケーション要件に応

じて調整できます。 
3. ネットワーク インターフェイスは、「Data Link」設定オプション内で、必要な PHY 接続に対して設定されま

す。必要なネットワーク情報(IP アドレス、ゲートウェイ アドレス等) がクライアントとサーバの両方に対して

設定されている事が必要です。内部 Ethernet ドライバ(GMAC)は、SAME54 デモ用に、KSZ8091 PHY ドライ

バを使って有効にされます。SAME54 Xplained Pro 評価用キットは、現時点では KSZ8091 を実装していま

す。MIIM ドライバは、MIIM 動作が完了した時に外部 PHY レジスタと通知にアクセスするための非同期読み書

きおよびスキャン動作をサポートします。 
 
図 5-4.  データリンクの設定 
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図 5-5.  NETCONFIG オプション

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Note: ネットワーク コンポーネントのこの設定は、Project Graph 上または TCP/IP Configuration プラグイン内でコ

ンポーネントをクリックする事により行えます。MPLAB Code Configurator グラフィカル ユーザ インターフェイス

(GUI) のその他の TCP/IP コンポーネントも、この方法で設定できます。 
 

5.2.1 FTP サーバの設定 
TCP/IP アプリケーション層の設定 

TCP/IP アプリケーション層の設定手順は以下の通りです。 
•     「TCP/IP Configuration」ウィンドウ内の「TCP/IP Layers」の下で[Application] をクリックします。 
•   「Application Layer」画面内で、TCP/IP Application Layer Configurator は以下のコンポーネントを有効にします。

ANNOUNCE、FTP SERVER、DHCP SERVER、SNTP、DNS CLIENT 
•   ANNOUNCE モジュールは、DHCP 対応ネットワーク上でのデバイスの探索を容易にします。DHCP CLIENT モ

ジュールは、アプリケーションがネットワーク上の DHCP サーバから IP アドレスを動的に取得する事を可能に

します。 
Note: FTP サーバ プロジェクトには FTP SERVER コンポーネントを追加すれば十分であり、FTP クライアント プ
ロジェクトには DNS と一緒に FTP CLIENT コンポーネントを追加すれば十分です。上記のコンポーネントは、追加

のネットワーク プロトコルです。 

図 5-6.  FTP サーバ アプリケーション層の設定
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•   FTP サーバは、SD カード メディアからファイルにアクセスするために FAT FS を使います。FTP SERVER の設定

では、FTP サーバのルート ディレクトリのパスを設定します(図 5-7 参照)。 
 
図 5-7.  FTP サーバの設定 

 
 

5.2.2 FTP クライアントの設定 
TCP/IP アプリケーション層の設定 

TCP/IP アプリケーション層の設定手順は以下の通りです。 

•   クライアントに対しては、TCP/IP Application Layer Configurator 内で ANNOUNCE、FTP CLIENT、DHCP 
CLIENT コンポーネントが有効にされます。 

 
図 5-8.「FTP Client Application Layer Configurator」画面 

 
 

• FTP CLIENT の設定では、[Enable Console Commands] オプションにより、ユーザがシリアル ターミナルを

介して FTP クライアントと通信する事が可能となります。送信バッファと受信バッファのサイズは、必要に

応じて増やす事ができます(最大 1,024 バイト)。 
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図 5-9.  FTP クライアントの設定 

 
 
 

5.3 応用例の実行 
 

5.3.1 ハードウェアのセットアップ 
ハードウェアのセットアップ手順は以下の通りです。 

1. IO1 Xpro ボードを SAME54 Xplained Pro 評価用キットの EXT1 に接続します。 
2. IO1 Xpro ボードの裏面にある microSD カードスロットに microSD カードを挿入します。FTP サーバ側の SD

カードには、FTP クライアントによってダウンロードされるバイナリ(test.bin)を格納します。 
3. コンピュータからの micro-USB ケーブルを SAM E54 Xplained Pro 評価用キットの DEBUG USB コネクタに接

続します。 
4. RJ45 ケーブルを使って、サーバ側とクライアント側の SAM E54 Xplained Pro 評価用キットの RJ45 ポートを

互いに接続します。 
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図 5-10.  SAM E54 クライアント/サーバの接続 

 
 
 

5.3.2 MCU のプログラミング 
 
MCU のプログラミング手順は以下の通りです。 
 
1. FTP クライアント プロジェクトと FTP サーバ プロジェクトをダウンロードします(これらは本書と一緒に提供

される他、FTP Client と FTP Server からダウンロードできます)。 
2. MPLAB X IDE 内でプロジェクトを開きます(File > Open Project とメニューを操作し、

same54_ftp_client\firmware\ftp_client_sam_e54_xpro.X と
same54_ftp_server\firmware\ftp_server_sam_e54_xpro.X を指定)。  

3.  アイコン(Make and Program Device)をクリックする事により、両方の SAM E54 Xplained Pro 評価用キ

ットボードに対してプロジェクトをビルドおよびプログラミングします(クライアント側ボードにはクライアン

ト プロジェクト(ftp_client_sam_e54_xpro)をプログラミングし、サーバ側ボードにはサーバ プロジェク

ト(ftp_server_sam_e54_xpro)をプログラミング)。 
 

 

5.3.3 FTP サーバの接続 
FTP サーバの接続手順は以下の通りです。 

1. FTP サーバ側の SAM E54 Xplained Pro 評価用キットボードに DEBUG USB ポートを介して電源を投入しま

す。 
2. このボード内のFTPサーバ プロジェクトをフラッシュし、 

ターミナル(Tera Term)  プロジェクト ファイルsame54_ftp_server\firmware\ftp_server_sam_e54_xpro.Xを開きます。   
3. フラッシュ後に FTP サーバは初期化を完了し、コンソールにサーバ IP アドレスが出力されます(図 5-11 参照)。 

https://github.com/Microchip-MPLAB-Harmony/reference_apps/releases/download/v1.5.0/same54_ftp_client.zip
https://github.com/Microchip-MPLAB-Harmony/reference_apps/releases/download/v1.5.0/same54_ftp_server.zip
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図 5-11.  FTP サーバのコンソール出力 

 
 

Note: SAM E54 FTP クライアント プロジェクト(Ethernet ブートローダ) へ接続する前に、アプリケーショ

ン バイナリ ファイル(same54_ftp_client/utilities/test.bin)を FTP サーバ側ボードの IO1 Xpro 拡

張ボードの microSD カードにコピーします。クライアントは、このバイナリ ファイルをダウンロードしてブ

ートローディングを実行します。 
 

5.3.4 FTP クライアントの接続 
FTP クライアント向けユーザ アプリケーションは、FTP 接続要求を開始する必要があります。この要求に対するサ

ーバからの応答に基づき、クライアントはログイン用のユーザ名とパスワードを提供する必要があります。FTP ク

ライアントがログインに成功すると、サーバとクライアントの間のデータ転送が可能になります(ユーザ独自のクラ

イアント/サーバ(Windows クライアント、組み込みサーバ/クライアント、Linuxサーバ等)がアプリケーション用に

使えます)。 

本書の応用例では、クライアントはサーバからバイナリファイルをダウンロードし、そのファイルをクライアント

側ボードの IO1 Xpro 上の SDカードに保存した後に、バイナリをマイクロコントローラにプログラミングします。 
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図 5-12.  FTP クライアント内の FTP ブートローダのフロー図 

 
 
FTP クライアントへの接続手順は以下の通りです。 

1. シリアル ターミナル ウィンドウ アプリケーション(Tera Term)から、SAM E54 Xplained Pro 評価用キットによ

ってエミュレートされた COM ポートへ接続します。 
2. アプリケーションを再起動します(SAM E54 Xplained Pro 評価用キットをリセットします)。 
3. IP アドレスがターミナルに表示されます(図 5-13 参照)。 

図 5-13.   FTP クライアントの初期化 

 
4. ユーザは、下記をタイプ入力する事により、FTP サーバに接続できます。 

       ftpc connect <server ip address> 
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5. 接続に成功したら、下記のログイン情報を入力します。 
   ftpc login <username> <password> 

6. ログイン後に、下記の ftpc を使って、サーバからバイナリをダウンロードするためのコマンドを取得します。 
ftpc get -a -a <test.bin> 

「Command Success」メッセージにより、バイナリのダウンロードに成功した事が示されます。 
7. このメッセージを受信した後に、コマンド「boot」を入力します。「boot」は、ダウンロードしたバイナリの

ブートローディングを開始するよう定義されています。 
8. プログラミングが完了した後に MCU はリセットされ、アプリケーション コードの実行が始まります。 

Note:  
• バイナリファイルは、ダウンロードおよびブートロード用に使われる必要があります。 
• ソースコードは LED 点滅用の same54_ftp_client/utilities/test.bin を格納しています。このバイナ

リは、SAME54 FTP サーバ プロジェクトをプログラミングした SAM E54 Xplained Pro 評価用キットの SD カー

ドに保存しておく必要があります。 

図 5-14.  出力 
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6. 補遺 

 
6.1 アプリケーション バイナリファイルの生成(テスト用アプリケーションの設定) 

通常、組み込みファームウェアは、フラッシュメモリのベースアドレスに書き込まれたブートローダを備えています。

アプリケーション イメージは、フラッシュメモリ内のブートローダ コードより後のアドレス領域に書き込まれます。

MPLAB X IDE 内のアプリケーション プロジェクトのバイナリファイルを生成するには、以下の手順を実行します。 
 

6.1.1 [Generate Fuse Settings] オプションを無効にする 
通常、SAM MCU のヒューズ設定は、プログラミング ツールにより書き込まれます。テスト用アプリケーションでは、

ヒューズ設定は無効にされます(テスト用アプリケーションはブートローダによりプログラミングされるため)。ヒュ

ーズ設定を有効にすると、バイナリファイルのサイズが増加します。 
6.1.2 [Application Start Address (Hex)] オプションを変更する 

アプリケーション開始アドレス値は、[フラッシュ ベースアドレス + ブートローダ サイズ] 以上である事が必要です。

この値は、生成中にブートローダ コードへ提供された値と一致する必要があります。ブートローダは、デバイスリセ

ット時にアプリケーション開始アドレス値を使ってアプリケーションへジャンプします。 

ヒューズ設定とアプリケーション開始アドレスは、MCC を使って変更できます。MCC を起動し、図 6-1 に示す通り

に「System」コンポーネントを設定します。 
 
図 6-1.  MCC 内の「System」コンポーネントの設定 

 
アプリケーションの開始アドレスを変更するには、Project Properties > xc32-ld > Option categories: Symbols & Macros
と操作します。 ユーザは ROM_ORIGIN および ROM_LENGTH マクロを定義する必要があります。 
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図 6-2.   Project Properties 

 
 

6.1.3 MPLAB X IDE 内でバイナリファイルを生成する 
バイナリファイルを生成するための手順は以下の通りです。 

1. Project Properties > Building と操作します。 
2. [Execute this line after build] オプションを有効にし、下記のコマンドを挿入します。 

 

${MP_CC_DIR}\xc32-objcopy -I ihex -O binary "${DISTDIR}/${PROJECTNAME}.$ 
{IMAGE_TYPE}.hex" 
"${DISTDIR}/${PROJECTNAME}.${IMAGE_TYPE}.bin" 
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図 6-3.  バイナリファイルの生成 

 
 

プロジェクトのビルド後に、バイナリファイル出力は下記のパスで見つかります。 
<your_project>.X\dist\<config_name>\production\. 

 
 

6.2 ダウンロードしたバイナリの自己書き込み 
ユーザは、本書の FTP クライアント アプリケーションを使って、任意の FTP サーバ(どのような FTP サーバも使用

可能) から必要なアプリケーション ライブラリをダウンロードできます。クライアント ファイルシステム内にダウン

ロードされたバイナリファイルは、図 6-4 のフローチャートの通りに MCU のフラッシュメモリに書き込む事ができ

ます。フラッシュセクタの消去および書き込み動作の実装は、本応用例のソースコード内の APP_Flash_Task()関
数(same54_ftp_client\firmware\src\app.c) 内にあります。 
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図 6-4.  バイナリファイルのプログラミング 

 
 
 

6.3 アプリケーション コードの開始 
リセットのたびに、ブートローダ コードは以下を確認します。 

• ユーザボタン(SW0)が押されているかどうか 
• アプリケーションに割り当てられたフラッシュ アドレスに有効なアプリケーション コードが存在するかどうか 

これらの条件のどちらかが「真」である場合、FTP クライアント ブートローダは実行されず、実行はユーザ アプリ

ケーション コードへジャンプします。 

Note: 詳細は、アプリケーション ノート AN3475 を参照してください。 

https://ww1.microchip.com/downloads/en/Appnotes/File-Transfer-Protocol-Using-MPLAB-Harmonyv3-TCPIP-DS00003475A.pdf
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7. 参考資料 

• The Microchip TCP/IP スタック: 
ww1.microchip.com/downloads/en/appnotes/00833c.pdf 

• MPLAB® Harmony v3 TCP/IP ヘルプ: 
microchip-mplab-harmony.github.io/net/frames.html?frmname=topic&frmfile=index.html 

•   RFC 959: 
datatracker.ietf.org/doc/html/rfc959 

• Harmony v3 Microchip Developer Help: 
microchipdeveloper.com/harmony3:start 

• MPLAB Harmony GitHub wiki: 
github.com/Microchip-MPLAB-Harmony/Microchip-MPLAB-Harmony.github.io/wiki 

• TCP/IP アプリケーションを初めて作成する方法: 
github.com/Microchip-MPLAB-Harmony/net/wiki/Create-your-first-tcpip-application 

• MPLAB Harmony v2 から MPLAB Harmony v3 TCP/IP アプリケーションへの移行ガイド: 
microchip-mplab-harmony.github.io/quick_docs/source/migration/tcpiip_harmoy2_to_harmony_3/readme.html 

• ブートローダによるアプリケーションの設定: 
microchip-mplab-harmony.github.io/bootloader_apps_uart/apps/docs/ 
readme_configure_application_sam.html#configuring-an-application-to-be-bootloaded-for-cortex-m-based-mcus 

• MPLAB Harmony v3 は、MPLAB Code Configurator (MCC)を介して設定できます。MPLAB Harmony v3 を MCC
と組み合わせて使う方法については、以下のリンクを参照してください。 

– Create a new MPLAB Harmony v3 project using MCC 
– Update and Configure an Existing MHC-based MPLAB Harmony v3 Project to MCC-based project 
– Getting Started with MPLAB Harmony v3 Using MPLAB Code Configurator 
– MPLAB Code Configurator Content Manager for MPLAB Harmony v3 Projects 

• MPLAB® Code Configurator Overview with MPLAB Harmony Content: 
microchipdeveloper.com/harmony3:mcc-overview 

http://ww1.microchip.com/downloads/en/appnotes/00833c.pdf
https://microchip-mplab-harmony.github.io/net/frames.html?frmname=topic&frmfile=index.html
https://datatracker.ietf.org/doc/html/rfc959
https://github.com/Microchip-MPLAB-Harmony/Microchip-MPLAB-Harmony.github.io/wiki
https://github.com/Microchip-MPLAB-Harmony/net/wiki/Create-your-first-tcpip-application
https://microchip-mplab-harmony.github.io/quick_docs/source/migration/tcpiip_harmoy2_to_harmony_3/readme.html
https://microchip-mplab-harmony.github.io/bootloader_apps_uart/apps/docs/readme_configure_application_sam.html#configuring-an-application-to-be-bootloaded-for-cortex-m-based-mcus
https://microchip-mplab-harmony.github.io/bootloader_apps_uart/apps/docs/readme_configure_application_sam.html#configuring-an-application-to-be-bootloaded-for-cortex-m-based-mcus
https://www.youtube.com/watch?v=KdhltTWaDp0
https://www.youtube.com/watch?v=PRewTzrI3iE
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Microchip 社情報 

 
 

 

Microchip 社ウェブサイト 
 

 

Microchip 社はウェブサイト(www.microchip.com)を通してオンライン サポートを提供しています。当ウェブサイトで

は、お客様に役立つ情報やファイルを簡単に見つけ出せます。以下を含む各種の情報がご覧になれます。 

• 製品サポート - データシートとエラッタ、アプリケーション ノートとサンプル プログラム、設計リソース、ユ

ーザガイドとハードウェア サポート文書、最新のソフトウェアと過去のソフトウェア 
• 技術サポート – FAQ(よく寄せられる質問)、技術サポートのご依頼、オンライン ディスカッション グループ、

Microchip 社のデザイン パートナー プログラムおよびメンバーリスト 
• ご注文とお問い合わせ - 製品セレクタと注文ガイド、最新プレスリリース、セミナー/イベントの一覧、お問い合

わせ先(営業所/正規代理店)の一覧 
 
製品変更通知サービス 

 
 

Microchip 社の製品変更通知サービスは、お客様に Microchip 社製品の最新情報をお届けする配信サービスです。ご興

味のある製品ファミリまたは開発ツールに関する変更、更新、リビジョン、エラッタ情報をいち早くメールにてお知

らせします。http://www.microchip.com/pcn にアクセスし、登録手続きをしてください。 

 
カスタマサポート 

 
 

Microchip 社製品をお使いのお客様は、以下のチャンネルからサポートをご利用になれます。 

• 正規代理店 
• 技術サポート 

サポートは販売代理店にお問い合わせください。各地の営業所もご利用になれます。本書の最後のページに各国の営

業所の一覧を記載しています。 

技術サポートは以下のウェブページからもご利用になれます。www.microchip.com/support 
 

Microchip 社のデバイスコード保護機能 
 

 

Microchip 社製品のコード保護機能について以下の点にご注意ください。 

• Microchip 社製品は、該当する Microchip 社データシートに記載の仕様を満たしています。 
• Microchip 社では、通常の条件ならびに仕様に従って使った場合、Microchip 社製品のセキュリティ レベルは、現

在市場に流通している同種製品の中でも最も高度であると考えています。 
• Microchip 社はその知的財産権を重視し、積極的に保護しています。Microchip 社製品のコード保護機能の侵害は

固く禁じられており、デジタル ミレニアム著作権法に違反します。 
• Microchip 社を含む全ての半導体メーカーで、自社のコードのセキュリティを完全に保証できる企業はありませ

ん。コード保護機能とは、Microchip 社が製品を「解読不能」として保証するものではありません。コード保護

機能は常に進歩しています。Microchip 社では、常に製品のコード保護機能の改善に取り組んでいます。 
 
法律上の注意点 

 
 

本書および本書に記載されている情報は、Microchip 社製品を設計、テスト、お客様のアプリケーションと統合する目

的を含め、Microchip 社製品に対してのみ使用する事ができます。それ以外の方法でこの情報を使用する事はこれらの

条項に違反します。デバイス アプリケーションの情報は、ユーザの便宜のためにのみ提供されるものであり、更新に

よって変更となる事があります。 

https://www.microchip.com/
https://www.microchip.com/pcn
https://www.microchip.com/support
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お客様のアプリケーションが仕様を満たす事を保証する責任は、お客様にあります。

その他のサポートは Microchip 社正規代理店にお問い合わせ頂くか、www.microchip.com/en-us/support/ design-
help/client-support-services をご覧ください。 

Microchip 社は本書の情報を「現状のまま」で提供しています。Microchip 社は、明示的、暗黙的、書面、口頭、法定

のいずれであるかを問わず、本書に記載されている情報に関して、状態、品質、性能、商品性、特定目的への適合性

をはじめとする、いかなる類の表明も保証も行いません。

いかなる場合も Microchip 社は、本情報またはその使用に関連する間接的、特殊的、懲罰的、偶発、的または必然的

損失、損害、費用、経費のいかんにかかわらず、また Microchip 社がそのような損害が生じる可能性について報告を

受けていた場合あるいは損害が予測可能であった場合でも、一切の責任を負いません。法律で認められる最大限の範

囲を適用しようとも、本情報またはその使用に関連する一切の申し立てに対する Microchip 社の責任限度額は、使用

者が当該情報に関連して Microchip 社に直接支払った額を超えません。 

Microchip 社の明示的な書面による承認なしに、生命維持装置あるいは生命安全用途に Microchip 社の製品を使用する

事は全て購入者のリスクとし、また購入者はこれによって発生したあらゆる損害、クレーム、訴訟、費用に関して、

Microchip 社は擁護され、免責され、損害をうけない事に同意するものとします。特に明記しない場合、暗黙的あるい

は明示的を問わず、Microchip 社が知的財産権を保有しているライセンスは一切譲渡されません。 

商標

Microchip 社の名称とロゴ、Microchip ロゴ、Adaptec、AVR、AVR ロゴ、AVR Freaks、BesTime、BitCloud、
CryptoMemory、 CryptoRF、 dsPIC、 flexPWR、 HELDO、 IGLOO、 JukeBlox、 KeeLoq、 Kleer、 LANCheck、
LinkMD、maXStylus、maXTouch、MediaLB、megaAVR、Microsemi、Microsemi ロゴ、MOST、MOST ロゴ、

MPLAB、OptoLyzer、PIC、picoPower、PICSTART、PIC32 ロゴ、PolarFire、Prochip Designer、QTouch、SAM-
BA、SenGenuity、SpyNIC、SST、SST ロゴ、SuperFlash、Symmetricom、SyncServer、Tachyon、TimeSource、
tinyAVR、UNI/O、Vectron、XMEGA は米国およびその他の国における Microchip Technology Incorporated の登録商

標です。

AgileSwitch、APT、ClockWorks、The Embedded Control Solutions Company、EtherSynch、Flashtec、Hyper 
Speed Control、HyperLight Load、Libero、motorBench、mTouch、Powermite 3、Precision Edge、ProASIC、

ProASIC Plus、ProASIC Plus ロゴ、Quiet-Wire、SmartFusion、SyncWorld、Temux、TimeCesium、TimeHub、
TimePictra、TimeProvider、TrueTime、ZL は米国における Microchip Technology Incorporated の登録商標です。 

Adjacent Key Suppression、 AKS、 Analog-for-the-Digital Age、 Any Capacitor、 AnyIn、 AnyOut、 Augmented 
Switching 、 BlueSky 、 BodyCom 、 Clockstudio 、 CodeGuard 、 CryptoAuthentication 、 CryptoAutomotive 、

CryptoCompanion、CryptoController、dsPICDEM、dsPICDEM.net、Dynamic Average Matching、DAM、ECAN、

Espresso T1S、EtherGREEN、GridTime、IdealBridge、In-Circuit Serial Programming、ICSP、INICnet、Intelligent 
Paralleling、IntelliMOS、Inter-Chip Connectivity、JitterBlocker、Knob-on-Display、KoD、maxCrypto、maxView、
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